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ABSTRAK 

Armin Ridha. Dampak Perubahan Penggunaan Lahan Terhadap Sedimentasi Daerah 

Tangkapan Air Rencana Pembangunan Bendungan Pembangkit Listrik Tenaga Air 

Buttu Batu (dibimbing oleh Mahmud Achmad dan Roland A. Barkey) 

 

Penelitian ini bertujuan (1) melakukan skenario perubahan penggunaan lahan 

tahun 2020 hingga tahun 2120 kedepan pada Daerah Tangkapan Air (DTA) Rencana 

Pembangunan Pembangkit Listrik Tenaga Air (PLTA) Buttu Batu, (2) 

mengidentifikasi luasan kelas sedimen berdasarkan Sub Das Rencana Pembangunan 

PLTA Buttu Batu dimasa akan datang, (3) menyusun arahan penggunaan lahan yang 

tepat dalam menurunkan besaran hasil sedimen DTA Bendungan Buttu Batu.   

Penelitian ini dilaksanakan pada tahun 2021 di wilayah Daerah Tangkapan Air (DTA) 

Buttu Batu pada rencana pembangunan Bendungan PLTA Desa Buttu Batu, 

Kecamatan Enrekang, Kabupaten Enrekang, Provinsi Sulawesi Selatan. Data di 

analisis dengan menggunakan analisis model Cellular Automata dalam prediksi 

penggunaan lahan dan analisis model Hidrologi model SWAT untuk mengeluarkan 

data kelas sedimen. 

 

Hasil penelitian menunjukkan (1) terjadi dinamika perubahan penggunaan 

lahan dimasa yang akan datang tahun 2120 di DTA Buttu Batu berupa peningkatan 

luasan pemukiman, sawah dan pertanian lahan kering, (2) hasil sedimen dari tahun 

2020 hingga tahun 2120 mengalami peningkatan luasan kelas sedimen tinggi dan 

sangat tinggi pada 180 Sub Das dan (3) arahan penggunaan lahan yang direncanakan 

untuk menanggulangi kelas sedimen tinggi dan sangat tinggi dengan memaksimalkan 

penggunaan lahan berupa lahan terbuka dilakukan penenaman pohon dan penerapan 

kombinasi lahan kehutanan dan pertanian musiman. Penerapan tersebut mampu 

menekan kelas sedimen tinggi dan sangat tinggi tahun 2120 dan menjadi berkurang 

menjadi 145 Sub Das dari kelas tinggi, sangat tinggi ke kelas rendah dan sangat rendah. 

 

Kata Kunci : Cellular Automata,Hidrologi, DTA Buttu Batu,Bendungan 
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ABSTRACT 

Armin Ridha. The Impact of Changes in Land Use on the Sedimentation of the 

Watershed Dam Development Plan for the Buttu Batu Hydroelectric Power Plant 

(supervised by Mahmud Achmad and Roland A. Barkey) 

 

This study aims to (1) carry out scenarios of changes in land use from 2020 to 

2120 in the future in the Water Catchment Area (DTA) of the Buttu Batu Hydroelectric 

Power Plant (PLTA) Development Plan, (2) identify the area of sediment class based 

on the Buttu Hydropower Development Plan Sub-Das Batu in the future, (3) develop 

appropriate land use directions in reducing the amount of sediment yield from the Buttu 

Batu Dam catchment area. This research was carried out in 2021 in the Buttu Batu 

Catchment Area (DTA) in the planned construction of the Buttu Batu Hydropower 

Dam, Enrekang District, Enrekang Regency, South Sulawesi Province. The data were 

analyzed using the Cellular Automata model analysis in predicting land use and the 

SWAT Hydrological model analysis to extract sediment class data. 

 

The results showed (1) the dynamics of land use change in the future in 2120 in 

the Buttu Batu catchment in the form of an increase in the area of settlements, paddy 

fields and dry land agriculture, (2) sediment yields from 2020 to 2120 experienced an 

increase in the area of high sediment class and very high in 180 sub-watersheds and 

(3) land use directives planned to tackle high and very high sediment classes by 

maximizing land use in the form of open land by planting trees and applying a 

combination of forestry land and seasonal agriculture. This application was able to 

suppress high and very high sediment classes in 2120 and was reduced to 145 sub-

watersheds from high, very high to low and very low classes. 

 

Keywords: Cellular Automata,Hidrology Buttu Batu DTA, Dam 
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BAB I. PENDAHULUAN 

1.1. Latar Belakang 

Sumber daya air merupakan informasi yang sangat penting bagi perencanaan 

wilayah jangka panjang karena diperlukan guna terwujudnya segala aspek kehidupan 

(Abbaspour dkk., 2009). Salah satu sumber daya air yang memiliki peranan besar 

adalah sungai, sebagaimana  dipahami sebagai aliran air dalam skala besar yang 

mengalir terus-menerus secara gravitasi dari tempat tinggi (hulu) menuju ke tempat 

yang lebih rendah (hilir). Sungai memiliki peran yang sangat penting bagi pemenuhan 

kebutuhan dasar manusia dan pertumbuhan ekonomi suatu wilayah (Bharati dkk., 

2014). Khusus di Indonesia, sungai di manfaatkan untuk pemenuhan air lahan petanian, 

budidaya ikan serta pada beberapa wilayah digunakan sebagai sarana transportasi 

(Rijal.S dkk.,2021). Bahkan saat ini, air sungai bukan hanya semata pemenuhan hal-

hal tersebut tapi telah menjadi sumber energi terbarukan seperti generator listrik (Muis 

dkk., 2020). 

Sumber energi terbarukan saat ini terus didorong karena kebutuhan energi 

semakin meningkat yang searah dengan pertambahan jumlah penduduk. Nawa cita 

pemerintah Indonesia yang tertuang dalam target RPJMN Periode 2020-2024 ingin 

mewujudkan pencapaian target rasio elektrifikasi secara nasional dari 86,74 persen 

yang saat ini menjadi 97,35 persen diakhir periode RPJMN. Dalam mendukung nawa 

cita tersebut tentunya banyak hal yang perlu diperhatikan terkhusus dalam 

merencanakan Pembangkit Listrik Tenaga Air (PLTA) sebagai sumber energi listrik. 

Pembangkit listrik tenaga air merupakan salah satu sumber energi baru terbarukan yang 

memiliki potensi cukup besar di Indonesia karena banyaknya sungai dan danau yang 

deras airnya (Muis dkk., 2020).  

Akan tetapi terdapat beberapa hal yang perlu diperhatikan dari pembangunan 

pembangkit tenaga listrik dari tenaga air yang menggunakan sungai adalah faktor 

sedimen. Sedimen yang terjadi setiap saat dapat mempengaruhi umur bendungan yang 
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menyuplai tenaga air ke turbin. Proses sedimen apabila berlangsung terus menerus 

tanpa adanya kendali yang memadai akan mengakibatkan kerusakan lingkungan yang 

sangat luas sehingga berpengaruh terhadap pengelolaan DAS (Febrianingrum dkk, 

2011). 

Saat ini pemerintah sedang merencanakan pembangunan bendungan PLTA 

Berkapasitas 2x100 MW berada pada Daerah Tangkapan Air Buttu Batu. 

Mengantisipasi perencanaan strategis dimasa akan datang, kajian terkait dinamika 

penggunaan lahan guna menjaga kesetimbangan kondisi hidrologi sangat penting 

dilakukan. Buttu Batu yang merupakan Sub Daerah Aliran Sungai (DAS) Saddang saat 

ini terus mengalami ancaman terhadap peningkatan erosi dan sedimen. Hal yang wajar 

terjadi, mengingat bahwa Darah Aliran Sungai (DAS) Saddang masuk dalam kategori 

DAS prioritas atau harus dipulihkan (Hunggul, 2015).  

Kondisi masyarakat sangat berkaitan langsung dengan aktifitas penggunaan 

lahan pada suatu wilayah hingga perubahan penggunaan lahan dapat terjadi setiap saat, 

baik dari alam maupun dari aktivitas manusia. Selain itu penggunaan lahan disuatu area 

dengan pertumbuhan kependudukan yang tinggi dengan segala aktifitasnya, dapat 

memberikan pengaruh meningkatnya dampak negatif terhadap lahan (Chairil, Barkey, 

dkk., 2021). Pertumbuhan penduduk aktivitasnya yang lebih intens hingga dapat 

menjadi pemicu perubahan penggunaan lahan (Khawaldah, dkk., 2020). 

Diperlukan kajian faktor-faktor penyebab (Driving Faktor) terjadinya 

perubahan penggunaan lahan, faktor penghambat (Counstrain) untuk melihat sejauh 

mana perubahan lahan yang dapat mengancam fungsi hidrologi pada bendungan pasca 

dibangun. Melihat besaran sedimen yang terjadi akibat perubahan penggunaan lahan 

menggunakan Soil and Water Assessment Tool (SWAT) yakni program berbasis GIS. 

Program ini yang dapat menyelesaikan permasalahan pada DAS, salah satu 

kemampuannya untuk memprediksi sedimen pada badan sungai. sehingga dapat 

menjadi pertimbangan dalam memberikan rekomendasi arahan penggunaan lahan 

untuk menjaga kesetimbangan kondisi hidrologi. 
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1.2. Rumusan Masalah 

1. Bagaimana dinamika perubahan lahan yang terjadi pada DTA Bendungan Buttu 

Batu 

2. Bagaimana luasan kelas sedimen yang terjadi pada DTA Bendungan Buttu Batu 

dimasa mendatang. 

3. Bagaimana Strategi penanggulangan sedimentasi keluaran pada DTA Bendungan 

Buttu Batu.  

1.3 Tujuan Penelitian 

1.   Melakukan skenario perubahan penggunaan lahan 100 tahun (Tahun 2120) 

kedepan pada DTA Rencana Pembangunan PLTA Buttu Batu. 

2.  Menganalisis luasan kelas sedimen DTA Rencana Pembangunan PLTA Buttu 

Batu dimasa akan datang. 

3.  Menyusun arahan penggunaan lahan yang tepat dalam menurunkan besaran hasil 

sedimen DTA Bendungan Buttu Batu. 

1.4. Kegunaan Penelitian 

Kegunaan dari penelitian ini adalah untuk memberikan informasi mengenai 

kondisi perubahan penggunaan lahan dan besaran sedimentasi DTA Bendungan Buttu 

Batu. Serta menghasilkan desain rekomendasi arahan penggunaan lahan, dari hasil 

penelitian ini juga dapat dijadikan sebagai policy intervention bagi pemerintah 

setempat, guna pengamanan infrastruktur PLTA Buttu Batu nantinya. 
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BAB II. Metode Penelitian 

2.1. Waktu dan Tempat 

Penelitian ini dilaksanakan pada tahun 2021 di wilayah Daerah Tangkapan Air 

(DTA) Buttu Batu pada rencana pembangunan Bendungan PLTA Buttu Batu. lokasi 

bendungan nantinya berada di Desa Buttu Batu, Kecamatan Enrekang, Kabupaten 

Enrekang, Provinsi Sulawesi Selatan. Secara administrasi DTA PLTA Buttu Batu 

mencakup kabupaten di Provinsi Sulawesi Selatan yakni Toraja Utara, Tana Toraja, 

Enrekang dan Pinrang, sedangkan di Provinsi Sulawesi Barat hanya mencakup 

Kabupaten Mamasa. 

 

Gambar 1. Peta Lokasi Penelitian 

2.2. Alat dan Bahan 

Penelitian ini menggunakan alat dan bahan yang sesuai dengan keperluan 

pengambilan dan analisis data. Alat yang akan digunakan dalam penelitian ini yaitu 
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receiver GPS (Geographic Positioning System), kamera digital, drone dan personal 

computer (PC)/laptop yang memiliki software SIG dan Software landuseSim. Adapun 

bahan yang digunakan dalam penelitian ini diantaranya data berbasis spasial meliputi 

batas DAS, administrasi wilayah, sungai utama, anak sungai, jalan, kontur, data 

penggunaan lahan, jenis tanah, data iklim, kawasan pemukiman dan kawasan hutan. 

2.3. Sumber Data dan Variabel Penelitian 

Data penelitian ini dibedakan berdasarkan sumbernya yang terdiri dari data 

primer dan data sekunder. Data primer adalah data yang diperoleh melalui: data DEM 

yang diolah secara Interpolation Topo to Raster, sungai, dan batas DAS, 

Data sekunder adalah data yang menyangkut keadaan umum lokasi penelitian 

yang diperoleh dari studi literartur beserta data dan informasi lainnya yang terkait 

langsung ataupun tidak langsung dengan penelitian. Data sekunder meliputi data 

spasial administrasi, Data DEM (Digital Elevation Model), jenis tanah, Kawasan 

hutan,Penggunaan lahan dan data iklim harian 10 tahun terakhir serta data harian curah 

hujan dan temperatur harian maksimum dan minimum. 

Tabel  1. Daftar Data Spasial dan Sumbernya 

No. Judul Sumber 

1. Batas DAS Saddang 

Dirjen Pengelolaan Daerah Aliran 

Sungai Hutan Lindung,Kementerian 

Lingkungan Hidup Dan Kehutanan 

tahun 2018 

2. Data Akses jalan 
Portal Geospasial Indonesia 

(http://tanahair.indonesia.go.id) 

3. Data Digital Elevation Model DEMNAS 8 M (tides.big.go.id) 

4. 

Penggunaan lahan Tahun 

2010,2015 dan 2020 dan Peta 

Kawasan Hutan 

Balai Pemantapan Kawasan Hutan 

Kementerian lingkungan Hidup dan 

Kehutanan  

5. Jenis tanah 

Landsystem 1987, Regional Phsyical 

Planning Project For Transmigration 

(RePPProT) 

6. Data Iklim  
Data satelit merra 2 melalui Website: 

Power.larc.nasa.gov/data-acces-viewer 

7 Data Debit Air 
Automatic Water Level Recorder 

(AWLR) PT Malea 
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2.4. Prosedur Penelitian 

2.4.1. Pengumpulan Data 

1. Data Elevation Model 

Data digital elevation model (DEM) dibuat menggunakan pendekatan Sistem 

Informasi Geografis dengan tools “Interpolation Topo to Raster” dengan 

menggunakan data shapefile batas wilayah kajian (Batas DTA Indikatif Pembangunan 

PLTA Buttu Batu), dan data shapefile jaringan sungai. 

2. Data Penggunaan Lahan dan Kawasan Hutan 

Peta history penggunaan lahan dan Peta Kawasan Hutan bersumber dari Balai 

Pemantapan Kawasan Hutan (BPKH). Data penggunaan lahan BPKH biasanya dapat 

diakses melalui publikasi dan laporan yang dikeluarkan oleh BPKH. Laporan tersebut 

dapat berisi informasi tentang penggunaan lahan hutan, perubahan tata guna lahan, 

serta rencana pengelolaan kawasan hutan di masa yang akan datang. Data penggunaan 

lahan dapat diperoleh dengan format (.shp).  

Klasifikasi penggunaan lahan yang telah diperoleh dari data BPKH lalu 

diterjemahkan kedalam klasifikasi SWAT. Adapun penyesuaian atribut SWAT dengan 

kondisi penggunaan lahan hasil interprestasi citra dapat dilihat pada Tabel 2 berikut; 

Tabel  2. Klasifikasi Penamaan Penggunaan Lahan untuk Model SWAT  

No Penggunaan lahan Klasifikasi SWAT 
Kode 

SWAT 

1 Hutan Forest-Mixed FRST 

2 Semak Belukar Range-Brush RNGB 

3 Savana/Padang Rumput Pasture PAST 

4 Pertanian Lahan Kering Agriculture Land-Generic AGRL 

5 Sawah Rice RICE 

6 Tambak Water WATR 

7 Perkebunan Orchard ORCD 

8 Pemukiman Residential URBN 

9 Bandara/Pelabuhan Transportation UTRN 

10 Lahan Terbuka Oak OAK 

11 Tubuh Air Water WATR 

12 Rawa Wetlands-Mixed WETL 

Sumber: APPENDIX (2005). 
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3. Data Fisik dan Kimia Tanah 

Data jenis tanah berupa klasifikasi jenis tanah dan parameter sifat fisik dan 

kimia tanah. Data tersebut diperoleh dari Peta RePPProt (Regional Physical Planning 

Project for Transmigration), yang dilengkapi dengan parameter fisik dan kimia tanah 

yang diperoleh dari Model Hidrologi Soil And Water Asessment Tools (SWAT) 

Berbasis Data Spasial di Pulau Sulawesi (Nursaputra, 2022), selanjutnya 

ditransformasikan kedalam bentuk database klasifikasi jenis tanah kedalam model 

SWAT. 

4. Data Kelerengan 

Data kelerengan yang digunakan sebagai input data SWAT merupakan hasil 

dari ekstraksi data DEM menggunakan model SWAT. Penentuan klasifikasi kelas 

lereng mengacu pada Perdirjen BPDASPS Nomor P.4/V-SET/2013 yang membagi ke 

dalam 5 kelas lereng sesuai dengan kelas lereng kebutuhan input data SWAT yaitu 0-

8 persen (datar), 8-15 persen (landai), 15-25 persen (agak curam), dan >40 persen 

(sangat curam). 

5. Data Iklim 

Data iklim harian diperoleh dari satelit Merra-2 National Aeronautics and Space 

Administration (NASA) melalui website power.larc.nasa.gov/data-access-viewer, 

Adapun cara memperoleh data iklim sebagai berikut; 

1. Menentukan batasan pengambilan data menggunakan batas wilayah kajian 

(batas DTA Buttu Batu), 

2. Membuat grid menggunakan titik stasiun CSIRO dengan interval 5 km dan 

menentukan titik stasiun yang mempengaruhi wilayah kajian, 

3. Membuka website pada link power.larc.nasa.gov kemudian memilih menu 

Power Data Access Viewer. Selanjutnya lakukan penyesuaian data pada menu 

Power Single Point Data Access, 

4. Memilih jenis data yang akan diunduh pada menu Chose a User Community 

pada penelitian ini menggunakan Agroclimatology, 
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5. Input titik koordinat stasiun pada poin latitude/longitude kemudian melakukan 

penyesuaian data sesuai kebutuhan meliputi data iklim periode tahun 2011−2020 

menggunakan format CSV, setelah itu klik Submit→CSV→Download. 

Data yang digunakan berupa data curah hujan (pcp), temperatur 

maksimum (tmp_max), temperatur minimum (tmp_min), kelembaban (rh), kecepatan 

angin (wind) dan radiasi matahari (solar). Data yang telah di download kemudian 

dikonversi ke format txt agar dapat dilakukan input data pada model SWAT. Data curah 

hujan, dilakukan perhitungan rata-rata curah hujan sebagai bahan dalam melakukan 

proyeksi perubahan iklim berdasarkan titik station ke model RCP 4.5 CSIRO MK 3.6.0 

menggunakan software SiBiaS.  

2.4.2. Model dan Simulasi Prediksi Penggunaan Lahan 

a. Pengumpulan Data 

Proses Penyiapan data dilakukan dengan menggunakan aplikasi SIG. Semua 

data awal yang berupa format shapefile atau dalam bentuk vector selanjutnya akan 

dikonversi menjadi data raster. Kemudian data raster yang telah diperoleh diubah 

kedalam format ASCII agar bisa digunakan dalam aplikasi LanduseSim. Proses ini 

terdapat tiga jenis data yang masing-masing memiliki bagian yaitu data penggunaan 

lahan, data constrain (pembatas) dan data driving factor (faktor pendorong). Langkah 

pertama yang dilakukan adalah data penggunaan lahan dan data constraint diberi kode 

berupa angka. Angka selain nol untuk merepresentasikan klasifikasi penggunaan lahan. 

Sedangkan untuk data constrain terdiri atas dua angka yakni 0 dan 1. Angka 0 yang 

dimasukkan akan dianggap pembatas dan angka 1 bukan pembatas dalam merunning 

model dan simulasi di LanduseSim. Sebelum diberi angka data-data constrain tersebut 

terlebih dahulu dilakukan proses identity atau ditumpangsusun dengan tools overlay-

identity. Sedangkan untuk proses penyiapan data driving faktor proses ini sedikit 

berbeda dengan penyiapan data yang dilakukan sebelumnya.  

Data driving faktor harus memperhatikan tingkat kedekatan terhadap variable 

atau faktor pendorong berupa analisis tingkat kedekatan dengan Kawasan maupun area 
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terbangung yang terjadi dilapangan, analisis tingkat kedekatan dengan jalan. proses ini 

menggunakan tools Euclidean distance. Hasil akhir dari proses ini dilakukan secara 

otomatis yang terkonversi dalam bentuk raster dan berupa nilai jarak Floating-point 

dengan angka yang berbeda tergantung dari keterkaitan antara variable satu dengan 

yang lainnya. Selanjutnya adalah menetapkan ukuran Cell sebelum di eksport menjadi 

data raster dengan menggunakan tools polygon to raster khususnya pada data 

penggunaan lahan dan Constrain. Ukuran cell yang dipilih adalah 30 x 30 (300m3). 

Dimana ukuran pixel sesuai dengan ukuran pixsel citra Landsat yang digunakan sebagai 

data dasar dalam pembuatan data penggunaan lahan tahun 2010 dan 2020 bersumber 

dari Balai Pemantapan Kawasan Hutan (BPKH) dan juga salah satu sumber data 

referensi yang digunakan. Selanjutnya untuk mengubah data raster menjadi data ASCII 

menggunakan tools raster to ASCII. 

b. Membangun Model 

Simulasi proyeksi penggunaan lahan pada DTA Buttu Batu dilakukan dengan 

mendesain model penggunaan lahan terlebih dahulu. Data pengunaan lahan tahun 2010 

akan dilakukan proses simulasi hingga tahun 2020. Output dari hasil tersebut dilakukan 

untuk memperoleh data tahun proyeksi lalu disandingkan dengan tahun aktual untuk 

memperoleh angka validasi sebagai bahan untuk mengetahui tingkat akurasi desain 

model yang dibangun. Model perubahan lahan menggunakan cellular automata (CA). 

Metode ini cukup efektif dilakukan dibeberapa peneliti seperti penelitian landuseSim 

sebagai Aplikasi Pemodelan dan Simulasi Spasial Perubahan Penggunaan Lahan 

Pratomoatmojo (2014), dan Analisis Perubahan Penggunaan Lahan Akibat 

Pembangunan Jalan Tol Di Kabupaten Siduarjo Menggunakan Citra Satelit 

Multitemporal Suprastyo dkk (2010). Salah satu aplikasi yang menggunakan algoritma 

CA dalam Simulasi dan Permodelan spasial adalah landuseSim. 
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Gambar 2. Algoritma Cellular Automata pada landuseSim (Pratomoatmojo, 2018) 

Menurut Pratomoatmojo (2014) landuseSim merupakan software simulasi dan 

pemodelan spasial berbasis grid/cell dengan menggunakan data raster penggunaan 

lahan sebagai atribut spasial. Selain itu Pengguna dapat mengontrol atau 

mengintervensi semua faktor dalam prosedur simulasi seperti target pertumbuhan, 

penentuan faktor pendorong, membuat skenario perencanaan, zonasi, simulasi multi-

landuse dan kemampuan untuk menciptakan status sel baru selama simulasi. 

Penggunaan landuseSim dalam beberapa studi pemodelan spasial sebelumnya pun 

dianggap berhasil dengan tingkat validasi model di atas 70 persen selain itu, penelitian 

lain juga melakukan model dengan penggunaan model Cellular automata dapat 

memprediksi pertumbuhan kota dengan akurasi hingga 75 persen (Arifah, 2018). 
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Gambar 3. Kerangka Simulasi Proyeksi Penggunaan Lahan Menggunakan 

LanduseSim  
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Proses Import dari ASCII ke aplikasi Landusesim menggunakan peta 

penggunaan lahan dan peta constrain diimport sebagai bilangan integer (bilangan 

bulat), sedangkan untuk peta-peta driving factors diimport sebagai bilangan float 

(desimal). 

 

Gambar 4. Proses Import Data ASCII ke Aplikasi LanduseSim 

Tools fuzzy set dalam LanduseSim terbagi menjadi dua operasi, yaitu 

monotonically increasing dan monotonically decreasing khusus pada penelitian ini 

menggunakan variabel aksesibilitas (data jalan) dan jaringan sungai yang bersumber 

dari Portal Geospasial Indonesia, sedangkan keberadaan pemukiman diperoleh dari 

data penggunaan lahan BPKH. Selanjutnya data-data tersebut diberikan bobot sejauh 

mana pengaruh faktor tersebut dalam perubahan penggunaan lahan suatu wilayah. 

Penentuan bobot ini berdasarkan studi literatur yang diperoleh pada penelitian yang 

telah dilakukan.  
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Tabel  3. Bobot Penentuan driving factors dan constraint 

Faktor driving factors Bobot Dasar Teori 

Luas Permukiman  
4.0 

Penelitian yang dilakukan oleh 

Pratomoatmojo (2018) 

Jalan 
4.0 

Penelitian yang dilakukan oleh 

Pratomoatmojo (2018) 

Sungai 
2.0 

Penelitian yang dilakukan oleh 

Abkar, (2020) 

Faktor constraint 

 

Dasar Teori 

Kelerengan 40 Persen Undang-undang No.5/1990 tentang 

Sumber Daya Alam dan 

Ekosistemnya maupun No.32/1991 

dan Undang-Undang Tata Ruang 

No.24/1992 

 

Ketiga data driving factors akan menjadi faktor pendorong berdasarkan 

penelitian Pratomoatmojo (2018) pemukiman memberikan faktor yang dapat merubah 

penggunaan lahan suatu wilayah maka diberikan bobot 4.0. selain itu berdasarkan 

penelitian Abkar, (2020) yang berjudul Penggunaan Lahan dan Pengaruh Pertumbuhan 

Penduduk Tahun 2030 di daerah aliran sungai Kelara memasukkan jarak sungai 

kedalam faktor yang dapat mempengaruhi perubahan lahan didukung dengan 

pengamatan dilapangan yang memiliki potensi dalam perubahan lahan dengan bobot 

2.0. peta transisi yang memiliki batasan wilayah pertumbuhan maka dilakukan proses 

overlay dengan peta constraint berupa lereng diatas 40 persen,. Perhitungan faktor 

tersebut dilakukan dengan menstandarisasi peta jarak menggunakan Fuzzy Set untuk 

menghasilkan nilai riil antara 0 – 1. Monotonically increasing menghasilkan data raster 

yang memiliki potensi perkembangan terbaik jika semakin jauh dengan driving factors. 

Sedangkan monotonically decreasing menghasilkan data raster yang memiliki potensi 

perkembangan terbaik atau berpengaruh cepat terhadap perubahan jika semakin dekat 

dengan driving factors (Septawicaksono dan Pratomoatmojo, 2020). Berikut adalah 

proses standarisasi dari tools fuzzy. 
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Gambar 5. Proses Fuzzy pada Aplikasi LanduseSim 

 

Gambar 6. Fuzzy Pada Aplikasi LanduseSim  

Tahap pembuatan Peta Transisi/ initial transition potensial map dilakukan 

dengan overlay peta-peta yang dihasilkan dari proses fuzzy set menggunakan modul 

Weighted raster. Peta-peta tersebut akan diberi bobot berdasarkan tingkat pengaruhnya 

terhadap perubahan penggunaan lahan. Dimana peta jarak terhadap jaringan jalan 

diberi bobot dengan pertimbangan bobot tersebut diputuskan berdasarkan literatur yang 

ada dan melihat kondisi lapangan yang memungkinkan akan memberikan pengaruh 

terhadap perubahan penggunaan lahan suatu lokasi. 
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Gambar 7. Proses Penentuan Bobot Faktor Pendorong 

Model dengan skenario menggunakan constrain dilakukan mengoverlay 

dengan peta constraint untuk mendapatkan peta transisi yang memiliki informasi 

terkait wilayah mana yang tidak terkonversi ketika simulasi atau wilayah mana yang 

dibatasi terjadi perubahan lahan. Pada penelitian ini menggunakan data kelerengan 

yang berada diatas 40 persen akan menjadi faktor yang akan dibatasi jika dilakukan 

simulasi. 

 

Gambar 8. Proses Transition Potential Zoning (Import data Constrain) 
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Aturan transisi (transition rules) merupakan dasar transformasi setiap sel 

penggunaan lahan dari keadaan sekarang menjadi sel  penggunaan lahan yang baru 

dimasa depan. Oleh sebab itu, ada beberapa item yang perlu diperhatikan dalam 

menentukan aturan transisi meliputi  jenis penggunaan lahan yang disimulasikan akan 

berubah atau bertambah, initial transition potensial map, hambatan penggunaan lahan 

(Land  constrain) dan elastisitas perubahan penggunaan lahan (elasticity of  change). 

Selain aturan transisi tersebut (transition rules), tahun proyeksi, penentuan initial 

landuse, time step, dan neighborhood filter (NF) juga merupakan syarat untuk 

menjalankan perintah simulasi dalam LanduseSim. Perintah simulasi dalam 

LanduseSim menggunakan modul LUCC CA. Tampilan modul ini dapat dilihat pada 

Gambar 9 berikut ini. 

 

Gambar 9. Proses LUCC CA 

Dalam modul simulasi LUCC CA, start date (2020 Tahun) dan end date (2120 

Tahun) merupakan tahun awal dan tahun akhir dilakukan simulasi. Pada penelitian ini 

menggunakan literasi hingga 100 tahun kedepan. Dasar literasi ini mengikuti 

rancangan ketahanan bendungan Bili-Bili Sulawesi Selatan yang secara konstruksinya 

dapat bertahan hingga 70-100 Tahun setelah dibangun (Ma’waledha, 2021). 

Selanjutnya dilakukan Initial landuse merupakan data penggunaan lahan tahun awal 

yang akan disimulasi, set of transition rule merupakan aturan transisi yang menentukan 
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perubahan atau perkembangan lahan, time step merupakan banyaknya literasi 

(pengulangan) yang dilakukan selama periode simulasi dan neighborhood filter (NF) 

merupakan proses perhitungan ketetanggaan yang bekerja pada sistem grid. Pada 

umumnya yang paling populer digunakan adalah NF 3x3. Sebagaimana dilakukan oleh 

(Pratomoatmojo, 2018); (Rahmawati dan Pratomoatmojo, 2019) yang memilih 

menggunakan NF 3x3 agar model yang dihasilkan lebih kompak. 

Model perubahan penggunaan lahan selanjutnya akan divalidasi sebagai 

prasyarat untuk memprediksi atau mensimulasikan perubahan lahan DTA Buttu Batu 

kedepannya. Validasi bertujuan untuk mengetahui tingkat akurasi dari model yang 

dihasilkan. Salah satu teknik yang digunakan untuk menvalidasi model adalah teknik 

overall accuracy, Teknik ini merupakan rasio antara jumlah piksel benar dengan 

jumlah keseluruhan piksel dalam bentuk persentase. Validasi dalam kategori Baik 

berada pada angk 0,70 atau 70 persen yang berarti penggunaan lahan hasil simulasi 

cocok secara fungsi dan lokasi dengan penggunaan lahan eksisting (Arifah, 2018). 

 

Gambar 10. Validasi Nilai Data Penggunaan lahan aktual dan Proyeksi 



33 

 

c. Melakukan Simulasi Tahun 2120 

Tahapan simulasi tidak jauh berbeda dengan proses pembuatan model 

sebelumnya. Secara proses tetap sama, Semua tahapan simulasi dilakukan dalam 

LanduseSim. mulai dari tahap import data dari Software SIG, standarisasi data dengan 

fuzzy, pembobotan driving factor, penyiapan peta transisi, penentuan aturan transisi 

dan simulasi. Namun secara fungsi letak perbedaannya adalah bagaimana model yang 

dihasilkan dapat diterima atau mendekati kondisi real yang dibuktikan dengan uji 

validasi sedangkan simulasi cenderung kepada prediksi masa depan. Hasil proyeksi 

yang telah diperoleh selanjutnya dilakukan proses overlay untuk faktor-faktor yang 

menjadi pendorong dengan melakukan buffer 100 meter untuk melihat sejauh mana 

perubahan yang terjadi pada setiap penggunaan lahan. 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 11. Kerangka Simulasi Prediksi Penggunaan Lahan Tahun 2120 
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2.4.3. Proyeksi Curah Hujan dan Suhu Tahun 2100-an 

Program SiBiaS v1.1 dibuat untuk membantu memudahkan perhitungan 

proyeksi atau skenario perubahan iklim berdasarkan downscaling data GCM CMIP5 

khususnya untuk data curah hujan dan suhu bulanan. Program ini didesain untuk 

membantu menyiapkan data proyeksi iklim di daerah, dan grafik yang disediakan 

hanya bersifat untuk pengecekan hasil perhitungan. Proyeksi iklim tidak terlepas dari 

aspek ketidak pastian iklim masa depan, sehingga penggunaan beberapa model dapat 

meningkatkan kualitas proyeksi iklim. Namun demikian tidak semua model dapat 

digunakan, dibutuhkan studi literatur model GCM untuk menentukan model yang 

cocok di Indonesia. Model yang digunakan dalam penelitian ini adalah model skenario 

RCP4.5 CSIRO-Mk3-6-0, model tersebut dianggap sesuai dengan kondisi di Pulau 

Sulawesi.   

Proyeksi iklim dilakukan dengan tahapan sebagai berikut:  

1. Menyiapkan data curah hujan yang diperoleh melalui tahapan pengumpulan 

data pada Sub Bab Teknik Pengumpulan Data Iklim. 

 

2. Melakukan penyesuaian terhadap inputan data berdasarkan format penyusunan 

data yang telah ditentukan. 

 

3. Data curah hujan yang telah disesuaikan kemudian diinput masuk kedalam 

software. Selanjutnya, secara otomatis software akan membaca data observasi 

yang telah dimasukkan serta secara otomatis mengkalkulasikan tahun proyeksi 

yang akan dihasilkan 

 

4. Memilih scenario yang akan digunakan, dalam penelitian ini menggunakan 

skenario RCP4.5 dan GCM CSIRO Mk3.6.0 dengan proyeksi menggunakan 

metode delta. 
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5. Tahapan selanjutnya, melakukan simulasi dengan menekan tools start 

calculation pada menu. Hasil proyeksi kemudian dapat dilihat pada folder 

penyimpanan. 

 

Gambar 12. A Statistical Bias Correction Tool for Generating 

Climate Change Scenarios in Indonesia based on CMIP5 Datasets 

2.4.4. Prosedur Simulasi SWAT 

a. Delinasi Batas 

Tahap pertama dalam melakukan simulasi Model SWAT yaitu melakukan 

deliniasi DAS menggunakan data DEM yang telah dibuat sebelumnya. Deliniasi Batas 

DTA dilakukan dengan tahapan sebagai berikut:  

1) Membuat project SWAT menggunakan menu Swat Project→New Swat  

Project→Menyimpan file project pada folder yang telah disiapkan;  
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2) Menginput Data DEM yang telah dibuat pada Sub Bab Pengumpulan Data Digital 

Elevation Model menggunakan menu Watershed Deliniator→Automatic 

Watershed Deliniation→Memilih data DEM yang akan digunakan; 

3) Selanjutnya  melakukan  kalkulasi  data  pada  menu 

 Watershed Deliniator→Flow direction and Accumulation. Dalam penelitian 

ini number of cell yang disarankan kisaran 1837 − 367315 ha dan yang digunakan 

adalah 500 ha.  

 

Gambar 13. Proses Penentuan Treshold 

4) Menentukan jaringan sungai menggunakan menu Stream network → Create 

streams and outlets  
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Gambar 14. Proses Create streams and outlets 

5) Menentukan outlet (outlet definition) menggunakan menu Wholewatershed 

outlet→menyeleksi outlet sungai lokasi penelitian→Deliniate watershed  

 

Gambar 15. Proses outlet definition 

6) Melakukan perhitungan parameter Sub DAS (calculate subbasin parameter). 

Tahapan Deliniasi Sub Das selesai dilakukan.  
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Gambar 16. Proses calculate subbasin parameter 

b. Pembentukan Hydrological Response Unit  

Hydrological Response Unit (HRU) atu Unit Respon Hidrologi merupakan satuan 

lahan dengan unsur karakteristik sub DAS didalamnya. Pembentukan HRU dilakukan 

dengan metode sebagai berikut:  

1) Menginput peta penggunaan lahan dan jenis tanah yang telah diatur ke dalam 

format raster dan menggunakan system koordinat UTM. Tahapan awal dalam 

membuat data HRU yakni menggunakan menu HRU Analysis→Land 

Use/Soils/Slope Defenition.  
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Gambar 17. Proses Penginputan Nilai HRU 

2) Menginput peta penggunaan lahan menggunakan tools Land Use Data→memilih 

data penggunaan lahan→Choose grid fields→value→Lookup table→pilih data 

tabulasi penggunaan lahan yang telah dibuat dengan ekstensi txt→reclassify;  

 

 

Gambar 18. Proses Reclassify Penggunan Lahan 

3) Menginput peta jenis tanah menggunakan tools Soil Data→memilih data jenis 

tanah→Choose grid fields→value→Soil Database Options→User Soil→Lookup 

table→pilih data tabulasi jenis tanah yang telah dibuat dengan ekstensi 

txt→reclassify;  
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Gambar 19. Proses Reclassify Jenis Tanah 

4) Melakukan parameterisasi kelerengan menggunakan tools Slope→memasukkan 5 

kelas kelerengan (0-8 persen, 8-15 persen, 15-25 persen, 25-40 persen, >40 persen) 

→reclassify;  

 

Gambar 20. Proses Reclassify Kelas Lereng 

5) Ketiga data tersebut kemudian dilakukan proses overlay untuk membentuk 

kombinasi informasi dari setiap data yang menjadi karakteristik pada setiap 
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subDAS. HRUs yang terbentuk kemudian didefinisikan dengan batas nilai sebesar 

0% untuk mendapatkan jumlah kombinasi HRU yang optimal.  

 

Gambar 21. Proses Overlay HRU 

 

Gambar 22. Proses HRU Definition 

c. Pembuatan Basis Data Iklim Harian 

Input data iklim dilakukan dengan memilih menu Write Input Tables dengan cara 

pemanggilan file WGN (Weather Generator Data) yang telah ditranformasikan 

sebelumnya yakni curah hujan (pcp.txt), temperatur (tmp.txt), radiasi matahari 
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(solar.txt), kelembaban udara (rh.txt) dan kecepatan angin (wind.txt). Untuk input data 

CSIRO Mk3.5, setelah dilakukan input data iklim aktual tahun 2011-2020 selanjutnya 

adalah memilih menu Edit SWAT Input untuk memasukkan besaran persentase delta 

perubahan yang telah dianalisis sebelumnya. 

 

Gambar 23. Proses Input Data Iklim 

d. Menjalankan dan Membaca Hasil Model  

Simulasi Model SWAT dilakukan menjalankan tools Run SWAT pada menu SWAT 

simulation dengan mengatur periode waktu, versi SWAT, dan besaran waktu keluaran 

data yaitu harian, bulanan, atau tahunan. Selanjutnya menjalankan model SWAT 

untuk menghasilkan kondisi hidrologi. Tahapan ini diulang sebanyak tiga kali, 

disuaikan dengan kebutuhan peneliti. Sebelum melakukan simulasi terlebih dahulu 

pastikan bahwa tahapan Watershed Delineation, HRU Analysis, Write Input Table dan 

Edit SWAT Input (untuk input data model CSIRO Mk3.5) telah selesai dijalankan 

dengan sukses. Setelah proses running telah selesai dijalankan, maka selanjutnya 

adalah menampilkan output hasil simulasi menggunakan menu read SWAT output. 

Menyimpan hasil simulasi dengan memilih menu Save Simulations.   

e. Kalibrasi dan Validasi Model 

Kalibrasi bertujuan agar output dari model yang digunakan, hasilnya mendekati 

output dari DAS yang sebenarnya. Kalibrasi dilakukan dengan cara merubah beberapa 

nilai parameter sensitif yang berpengaruh terhadap nilai hasil simulasi. Uji kalibrasi 

dilakukan dengan koefisien determinasi (R2) dan NashSutcliffe Index (NSI).  
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Koefisien determinasi menunjukkan kedekatan antara nilai yang dihasilkan oleh 

model SWAT dengan hasil model SCS yang diasumsikan sebagai nilai terdekat 

dengan kondisi sesungguhnya di lapangan. Koefisien yang mendekati 1 menandakan 

nilai hasil simulasi memiliki nilai yang cukup dekat dengan nilai sesungguhnya. Data 

yang digunakan untuk proses validasi ini adalah data debit aktual AWLR PT Malea 

Energy dan data debit keluaran SWAT. 

2.4.5. Analisis Hasil Sedimentasi 

Analisis hasil sedimentasi dilakukan sebanyak tiga kali berdasarkan jumlah 

simulasi yang dilakukan. Bedasarkan hasil sedimen yang diperoleh melalui tahapan 

analisis maka dapat ditentukan kelas sedimen dengan mengacu pada klasifikasi muatan 

sedimen berdasarkan kelas yang tertera. 

Tabel  4. Klasifikasi Muatan Sedimen 

NO 
Muatan Sedimen 

(ton/ha/Tahun) 
Warna Keterangan 

1 ≤ 5  Sangat Rendah 

2 ˃ 5 - ≤ 10  Rendah 

3 ˃ 10 - ≤ 15  Sedang 

4 ˃15 - ≤ 20  Tinggi 

5 >20  Sangat Tinggi 

Sumber: P.61/Menhut-II/2014 

2.4.6. Arahan Penggunaan Lahan 

Arahan penggunaan lahan dalam penelitian ini didasarkan pada informasi 

tingkat sedimentasi dari keluaran model SWAT. Hasil analisis tingkat sedimentasi 

berdasarkan kondisi aktual (tahun 2020) digunakan untuk memberikan gambaran 

kondisi sedimentasi yang dihasilkan DTA Perencanaan Pembangunan Bendungan 

PLTA Buttu Batu. Sementara Sub DAS dengan tingkat sedimentasi yang meningkat 

dari kondisi aktual penggunaan lahan ke kondisi proyeksi akan dilakukan arahan 

penggunaan lahan. Sub DAS dengan tingkat sedimentasi yang meningkat (Kelas 

Sangat Tinggi dan Tinggi), dilakukan arahan penggunaan lahan dengan 

mempertimbangkan kelas kemampuan lahan dan keberadaan kawasan hutan pada 

lokasi penelitian. Setelah dilakukan arahan, maka akan dilakukan kembali simulasi 

hidrologi menggunakan hasil arahan untuk melihat kondisi sedimen yang akan 
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dihasilkan. Kriteria kelas kemampuan lahan yang digunakan dalam penelitian ini 

dijabarkan sebagai berikut. 

Tabel  5.  Kriteria klasifikasi kemampuan lahan 

Faktor 

Penghambat/ 

Penghambat 

Kelas Kemampuan Lahan 

I II III IV V VI VII VIII 

Lereng Permukaan A B C D A E F G 

Kepekaan Erosi 

(KE) 

KE1, 

KE2 

KE3 KE4, 

KE5 

KE6 (1) (1) (1) (1) 

Tingkat Erosi (e) e0 e1 e2 e3 (2) e4 e5 (1) 

Kedalam Tanah (k) k0 k1 k2 k3 (1) (1) (1) (1) 

Permeabilitas (P) P2, P3 P2, P3 P2, P3 P2, P3 P1 (1) (1) P5 

Drainase (d) d1 d2 d3 d4 d5 (2) (2) d0 

Kerikil/batuan (b) b0 b0 b1 b2 b3 (1) (1) b4 

Ancaman Banjir 

(O) 

O0 O1 O2 O3 O4 (2) (2) (1) 

Sumber: Klingebiel dan Montgomery (1993) dalam Arsyad (2010) 

Keterangan: 

(1) = dapat mempunyai sembarang sifat 

(2) = tidak berlaku 

(3) = umumnya terdapat di daerah beriklim kering 

 


